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Housekeeping

Atftendees are Questions? Webinar is CEU’s will be Email:
muted upon Enter them in being available jgossman@m
eniry the chat box, recorded - uponrequest walliance.org
or simply slides and (ICC and AlIA) with questions
unmute recording will
yourself and be sent {o
ask attendees
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About the Nebraska Training Program

Goal: prepare the Nebraska workforce for changes in construction best
practices

Focused on providing training to builders, code officials, design
professionals, public officials and students

For more information, visit:
hitps:.// www.mwadlliance.org/nebraska-energy-codes-training-program
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https://www.mwalliance.org/nebraska-energy-codes-training-program

Who We Are

The Midwest Energy Efficiency Alliance (MEEA) is a collaborative
network, promoting energy efficiency to optimize energy
generation, reduce consumption, create jobs and decrease
carbon emissions in all Midwest communities.

MEEA is a non-profit membership organization with 170+ members,
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About Matt/Verdatek Solutions

PPy

VERDATEK

SOLUTIONS

40+ Years in the Building Industry

Served as a Top Building Codes official in the St. Louis areaq.
Director of University of Missouri Columbia High Performance
Buildings Research Center. Created and Instructed
Curriculum for Students and Industry Professionals.

Currently Assisting University of Missouri Science & Technology
in Building and Energy Code Curriculum and Policy

ICC Member serving on 2012, 2015, 2018 and 2024 Energy
Code Development Committee. 2021 Building Code-
General Committee

NAHB-Approved Instructor for Advanced Building Science
and Advanced Business Management
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g @COMcheck Learning Objectives:

Basics of using the COMcheck software, reviewing generated
compliance reports and the latest and greatest new features.

1. Obtain an overview of the basic functions and how COMcheck
calculates compliance for the building envelope, interior and
exterior lighting.

. Be able to identify the construction specifications needed to
complete a compliance calculation in the software.

. Learn how to enter the building envelope, lighting, and mechanical
components intfo the software.

. Understand how the compliance reports are created and what they
entail.
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States that allow COMcheck
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Commercial Compliance Tools

Desktop Software Tools Ffe
I! \/ I Web-Based Tools

COMcheck”

Printed Materials

COMcheck- Web
Compliance Guides
f';l ] COMcheck™ Prescriptive Tables

Package Generator .
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[ﬂ]‘/COMcheck &/ COMcheck-Web"

COMcheck-Web simplifies commercial and high-
rise residential energy code compliance.

It performs just like COMcheck, the desktop version,
but you don't need to download or install any
software on your computer.

« Can exchange files between desktop and web
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http://www.energycodes.gov/comcheck/

COMcheck/COMcheck Web

« The COMcheck software product group makes it easy to
determine whether new commercial or high-rise
residential buildings, additions and alterations meet the
requirements of the IECC and ASHRAE Standard 20.1.

COMcheck also simplifies compliance for building
officials, plan checkers and inspectors by allowing them
to quickly determine if a building project meets the
code.
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Under the Purview of the Commercial Code
v Buildings with commercial use

v Multifamily residential buildings four stories or
greater in height

Not Under the Purview of the Commercial Code
x  One- and two-family residential
x R-2, R-3, R-4 three stories or less in height
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What About Mixed Use? - C101.4.1

Treat the residential building
porfion under the applicable
residential code

Treat the commercial building
porfion under the commercial
code

Code Official has final authority
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. Commercial Compliance Options

. 2018 IECC - Prescriptive

v’ C402 - Envelope
v C403 - Mechanical

.. ASHRAE 90.1-2016 v C404 - SWH 2018 IECC — Performance

v' C405 - Lighting —
. . « C407 - Total Building
AND Pick at Least One C406: Performance

@ R QC406.2 - Eff. HVAC Performance « C402.5 - Air Leakage

0C406.3 - Reduced Lighting Power » C403- Mandatory Mechanical
Provisions

2/0/1'8

0 C406.4 — Enhanced Lighting « C404 — SWH

Controls

QC406.5 — On-site Supply of
Renewable Energy

L C406.6 — Dedicated Outdoor Air
System

QC406.7 — High Eff. Service Water
Heating

U C406.8 - Enhanced Envelope
Performance

L C406.9 — Reduced Air Infiltration

« C405 - Lighting

» Building energy cost to be <
85% of standard reference
design building

INTERNATI ONAL
ENERGY CONSERVATION CODE




.Asﬁs\ 90.1 Simplified Approach Option for
HVAC Systems

The simplified approach is an optional path for buildings that
meet these criteria:

« Building is two stories or fewer in
height.

« (Gross floor areais less than
25,000 sq. ft.

« System serving single HVAC
zone

« Each HVAC system in the
building must comply with all 19
requirements.
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COMcheck: Who May Submit?

 The commercial energy code requires that a registered professional
submit compliance documentation (construction documents and
compliance verification).

In the IECC, Section C103.1 Construction Documents, General, the
wording states that construction documentation and other supporting
data shall be submitted in one or more sets with each application for a
permit.

The construction documents shall be prepared by a registered design
professional where required by the statutes of the jurisdiction in which
the project is to be constructed. Where special conditions exist, the
code official is authorized to require necessary construction documents
to be prepared by a registered design professional.

NEBRASKA

Good Life. Great Resources.

EEEEEEEEEEEEEEEEEEEEEEEEE CODE COUNCIL




Landing Page

{"I“/ COMcheck-Web

‘ o New Project ‘ PROJECT
Code/Location
Code:| 2009 [ECC v/
State: |A|abama V\
City: | Abbeville v/

If your location is not included here, choose a nearby
location with similar weather conditions.

Project Type

® New Construction () Addition ) Alterations

Project Details (optional)

This information will appear on the Edit Praject Details..

compliance repart.

MEEA

MIDWEST ENERGY EFFICIENCY ALLIANCE

¢

Project ffle ] frai Address | | Password | | Logln

2008 [FCC Register (§) | Forgotten Password?
INT.LIGHTING | BXT.LIGHTING | MECHANICAL B repors _" E
Exterior Lighting Areas
| Add Buiding Avea | | L™ Duplicate | | X Dekete |
Building Area Area Description Space Conditioning Area Wit
Select Area Cateqory... v
}
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—— Commercial Buildings

Building System Compliance Options
Prescriptive
Option
Envelope
Mandatory
. ] Provisions Trade Off Energy. Code
Lighting o Option Compliance
compliance options)
MGCHamcal Total Building
] Performance
HVAC
|
SWH
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Mandatory Requirements Include:

« Air Leakage

 Air barriers

» Fenestration air leakage

« Rooms Containing Fuel-burning Appliances

« Airinfakes, exhaust openings, stairways and shafts
« Loading dock weather seals

* Vestibules

« Recessed lighting

« Commissioning
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What is COMcheck™?

> Envelope
« trade-off calculations are based on envelope loads only
«» defines a proposed design and a budget design

> Lighting
«» Watts/square foot (LPDs)

> Mechanical

» short wizard to customize a list of requirements applicable to the
system identified
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Envelope Trade-Off Methods:

»ASHRAE 90.1 (Pre-2013) Normative Appendix C Methodology for
Building Envelope Trade-Off Option

+ 90.1-2007/2010
« 2009/2012 IECC

»ASHRAE 90.1-2013 Appendix C has Iimited performance method
(EnergyPlus) (New]

»2015 [ECC Component Performance Alternative (Total UA) (New)

NEBRASKA

Good Life. Great Resources. g |
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Project Types:

g. « Addition Trade-off compliance method

» Alferation Prescriptive compliance

NEBRASKA

Good Life. Great Resources.
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 New Construction: Trade-off compliance method
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Commercial Building Envelope Requirements

» Mandatory Requirements:
» Moisture Control
« Air Leakage

» Climate Specific
Requirements:

» Roof

» Above Grade Walls
«» Below Grade Walls
» Floor

» Slab

» Skylights, Windows, and
Doors

CODE OFFICIALS
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g. Requirements

.  Efficiency requirements

.. « ECOnomizer requirements

« Fan Power Limitation

.. « Mandatory requirements

 No compliance metric available

NEBRASKA

Good Life. Great Resources.
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Lighting Requirements

 Mandatory requirements. Conftrols, Switching
* Interior/Exterior lighting power requirements

Complies if total connected power <= lighting power

allowance
% COMcheck

NEBRASKA
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When do Lighting and Power Requirements
Apply?

« Original Installed Lighting System in a New Building, Addition, or Tenant
Build-out

 Existing Lighting System that is Altered
« Change in Occupancy that Increases Energy
« Change in Occupancy that requires less LPD as shown in the LPD tables

Exceptions:

« Alterations where less than 10% of the luminaires in a space are
replaced and installed interior power lighting is not increased

 Lighting within dwelling units

« Where 2 75% of permanently installed fixtures (except low-
voltage) are fitted for and include high-efficacy lamps

NEBRASKA

Good Life. Great Resources.
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. Electrical Lighting and Power Systems

.. Requirements

« Mandatory Interior Lighting requirements
« Required Controls
- Wattage/Efficiency Limits

Interior Lighting Power Allowances (watts/ft?)

Exterior Lighting Controls
» Required Controls
« Lamp Efficiency

Exterior Lighting Power Allowances (watts/ft?)

Dwelling Electric Meters

Electrical Transformers and Motors

« Vertical and Horizontal Transportation Systems and
Equipment

&‘M EEA NEBRASKA
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Landing Page

.. Vicomcecites i a e [t ) (200

2008 [ECC Register () | Forgotten Password?

.. ‘@N“"F”’j“t‘ PROJECT INT. LIGHTING | EXT,LIGHTING | MECHANICAL B feors |+ 9

Coe/Location Building Envelope and Interior Lighting Areas 34 (IaRGIN T F:\RE
Code: | 2009 IECC v|
‘ Add Building Area ‘ ‘ = Duplicate ‘ | X Delate ‘
State: | Alabama v|
City: ‘ Abbeville v ‘ Building Area Area Description Space Conditioning Area s
If your location is not included here, choose a nearby :
location with similar weather conditions. n Select Area Cateww'“ M
Project Type
® New Construction ) Addition ) Alterations
Project Details (optional) )
This information will appear on the Edit Praject Details...
compliance repart.

ASSOCIATION

M E EA NEBRASKA

MIDWEST ENERGY EFFICIENCY ALLIANCE Good Life. Great Resources.

¢

INTERNATIONAL

DEPT. OF ENVIRONMENT AND ENERGY CODE COUNCIL




@i Untitled.cck - COMcheck
File Edit WView Options RE=GTN Help

[~ ™ | ¥ Wy
Project Envelope
Location

State Pennsylvar
City Abbottstow

Project Type
) New Constr

Space Conditioning

() Nonresidential

90.1 ('89) Code

90.1 ("99) Standard
90.1 (2001) Standard
90.1 (2004) Standard
1998 IECC

2000 IECC

2001 1ECC

2003 IECC

Georgia
Massachusetts
Minnesota

New York

Yermont

L/ Kesiaenual () Semiheated

Area Category (Space-By-Space)

[ Add Category ]Onhf add Areas with lighting alterations

J Area Category I

Code: Standard 90.1-2004

Project Details {(optional)

7

This information will appear
on the compiance certificate.

| 56 Project Details. .

J

TitlesSitesF it

Altera Expand the Screen

Let’s take a closer
look at this area.

like other programs.

Asea ! w2 |

!

1 |Click to select category. ~l

|

Envelope T8D

Lighting

TBD

MEEA

MIDWEST ENERGY EFFICIENCY ALLIANCE
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COMcheck Basics

« COMcheck is a reflection of the difference between a
'design’ building energy performance factor (EPF) and a
‘code’ or budget building EPF.

* The methodology used to determine EPF is provided in
ASHRAE 90.1 Normative Appendix C: Methodology for
Building Envelope Trade-off Option.

NEBRASKA
Good Life. Great Resources
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.. Steps

COMcheck Project Specification

* Project

 Building Envelope Components
* Lighting

 Mechanical

 Requirements/ View/Print/ Save

MEEA NEBRASKA

MIDWEST ENERGY EFFICIENCY ALLIANCE
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Information You will need:

.. * Energy Code

 Builder and project location

» Area take-offs for envelope assemblies

* Insulation R-values, fenestration performance data
* Lighting fixture details

* Heating and cooling system details

» Service water heating details

MEEA NEBRASKA

EEEEEEEEEEEEEEEEEEEEEEEEEEEEEEE Good Life. Great Resources.
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Landing Page

{""‘/ COMcheck-Web

‘ g New Project ‘

PROJECT

¢

Code/Location

Code: | 2009 [ECC v

State: |Alabama V\

City: | Abbeville v|

If your location is not included here, choose a nearby
location with similar weather conditions.

Project Type

® New Construction ) Addition ) Alterations

Project Details (optional)

This information will appear on the Edit Project Details...

compliance report.

MEEA

MIDWEST ENERGY EFFICIENCY ALLIANCE

Project title

2009 IECC

u Email Address | |-',=,_:_’-.'.'.".'-' ‘ ‘ﬂ

Register &) | Forgotten Password?

INT, LIGHTING EXT, LIGHTING MECHANICAL

Building Envelope and Interior Lighting Areas BRSAC @R i F-1{E0

‘E Reports Z‘

\ﬁu

| Add Building Area ‘

‘ - Duplicate ‘ ‘ X Delete |

Building Area Area Description Space Conditioning Area

n Select Area Category...

NEBRASKA

Good Life. Great Resources.
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@& Untitled.cck - COMcheck
File Edit View Options REsGE

Code: Standard 90.1-2004

«4 Title Bar

Menu Bar
=] Toolbar

1 Make sure the
correct code is
chosen

y 90.1 ('89) Code
6 X ==
D g o 29) Standard
Project Envelope 90.1 (2001) SEEMacs sal
2000 IECC A
City Abbottstow
2001 IECC . e
2003 IECC
Project Type Georgia
O New Constr  Massachusetts Alterations
Minnesota
Space Conditioning New York LIWNE
Yermont
(& Nonresidentialr U rResgenual () Semiheated
Area Category (Space-By-Space)
[ Add Category JOntv add Areas with lighting alterations
l Area Category Asea I wm2 ]
i i
1 [Cick to select category. -~} I
Notes

Envelope

| Edk Project Details... |

T8D Lighting TBD

M E EA NEBRASKA

MIDWEST ENERGY EFFICIENCY ALLIANCE
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nvelope Requirements

O = & : "a W x = a8
Sregect [T —— AP O LW vey Entrd e Legiory e eyl
Moot B T ot Walt Ward o Doar Baswrrerrt Phoor
= i emirete P P Lrens Bren e ) @ mwamamar ” oo nae
Comwgoeow 1wt . e Al bviadetm e Lows adof mows U Faatme S
= e 4 Cetas Porrsswaime ” 1‘;.' - \\.‘.' Vacoow
Saxsrg !
& Ract L Friadiietey Ertwaty AN - d 138219 " 2% 0 le’
2 (% Exmesar Wal 1 Eonirete Bhxh 32 ~jwedas. ~fferrvwa . ~| 38330 2 I ae | e | |
B A oww 1 Wood-Fframed., 16" o.¢ . S isa "I i | 5% O35 1.4%
- Snzoew 2 | Wood-Framed,. 247 0 < | Clansg -~ %32 na 2. 190 O0FS o. 00
> aadow 3 | Steei~-Framed 16" o C Clarnng e | 207 "y i S50 O3S 1.4%
% Door ) Sigel-Framed 28" oc e T s | 278 " $. 108
7 Door 2 ] M‘Ia'z Boildeng Wail | Noe- S ~1 162 n2 2. 138
» Deor 3 Sobkd Concrete - - - . - S 313¢
- r—— &°. Solid Grouted
o Other U -Factor Options » &7, Pamaby Crouted, CTells Empry -
— &, Parmabhy Crouted, Cells insulaned
&". Unreinforced, Cells Ermpty
5. Unreinforced, Cells insulated
5", Sadid Crouted
£, Pamaly Crouted, Cells Empry
E". Partwalby Crouted, Cells sulaned
5" Unreinforced, Cells oty
£ Unreinforced, Celis Insulates
107, Satid Crautea
107, Partaly Crowted, Cells Ermpey
107, Partsaly Corowuted, Ceolly insulated
107 Unremmforced, Cells Empty
107, Unreinforced., Cells Insulateds
127 Solid Crauted
127 Partaalby Crowned, Cells Ermgpey
127 Parvalby Crowted, CTells Iinsulated
L. Unreinforced, Celis Emnpty
127 Unreinforced, Cells Insulatea
Ervvelopes FASSES Deawge IX Deter thar Code Ervvw oo e - IN aerer Lghteg TR Exsemce Lghteg TRD
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U/A Trade-Off Compliance

Corrgpharce P, ng UA trade off
Comrgiance. 12 2% Better Than Code Maxrruen UA. S00 Your UA 439

T N At v o The T 10 wTaan e A N e e B T e e S 0 e T e A -

L e e o I e e e e

Extence Wl Type A Steel Fraere, W oce 1220 130 S0 &
Wndow 2° Wood Frarme Doutile Parwe w Low-E ™ 03X =
Doce B Sold 41 0420 17
Extencr Wil Type B: Sheel Frame, 87 00 2513 130 S0 173
Wndow 1 Wood Frame Doubile Pame vt Low-£ 210 0.3 - =
Window 2 Wood Frame Doutie Pare v Low-E x 0330 10
Wndow 3. Wood Frame Doubile Parwe wih Low-& S 0330 e
Docr A Glass -4 0310 7
Roctf Type 1 Sheel JostRafer 8" 00 2x%0 823 o0 30 21
Window 4 - Saylght Metal Frame wih Thermal Breas Trple Pare b 0700 P
Window £ - Shytght Cther @ 0 %40 8

Conplance Sistermert The proposed bulding desgn desarbed here 5 consstert with the budang plans. specfcatons, and other
AN O Subrmalied wih the Derit Jppicaton The proposed Dulang has Deen desgied 10 mMeet he 2010 New York Erergy Comenrvan

Corstructon Code regumements n REScheck Verson 4 4 1 and 10 comply wih the mMandaiory "egurements 15300 n the RESoheck iInspect
Checkint
Narmwe - Toe oV | L ate
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= Envelope Screen

Code: 2001 IECC

@ EZ - Casestudy.cck - COMcheck
File Edit View Options Code Help

D TEH ¥ @B Xi= &

Project Envelope Lighting Mechanical

[ Roof || Skylight || Extwall |[ IntWall || Window |[ Door || Basement || FloorJI
2 Cavity C
Component Assembly Consttuptlon Gr Area Insulation |

Details
R-Value
___|Buiiding I |
1 Roof 1 | 20532 2 19.0
Building Components are added by clicking on these.
e i
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Windows — U-Factors

Table 102.3(1)
U-Value Default For Windows
Glazed Doors and Skylights

Frome Material and Product Type e e Single Pane Double Pane Triple Pane
Aeted wrthun ot theyraad el
Opsevabie (rchsfing Siing arsl ssrngang U=105 Mu=055 M U =037
s donm) 1.27 D.B7 l ‘
Fixed 113 D&
Genhen Warsowr 26D 1.81
Castosn Vol 1.22 D.73
Syl 1.98 1.21
Site g serabiesd Siopsesbfovesteesad plecey 1.36 D22 " -
> NFRC tested and certified
Opermatae (wwch g Shcing e s or default window U-value
Frxexd 1.08 D65 range
Genthen Viks wiorer 1.07 D62
Cusrtusin Wl T3S o > Use assembly U-value
Shopesifovesieesad - - H
SO —— S i o > All windows must meet or
Opevabie (rnchaing sdng aned sswgeng gless exceed
doxws) D50 D.57
Fooed D.58 D.56
Skyfight= 1.75 1.05
Wi vany T s
Opeyabie (Fnchaing sidng el ssrngey 1
pheass doaws) D85 D.55
Foed D58 D.56
Gesther Vids mioer 231 1.61
Siryfight 1.47 D.24
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Overhang/Projection Factor (PF)

MEEA

MIDWEST ENERGY EFFICIENCY ALLIANCE

PF= A/B
PF=0.5

NEBRASKA
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Questions so far?

Please type in chat or unmute

NEBRASKA

Good Life. Great Resources.
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Interior Lighting Compliance

¢

Mandatory Interior
Requirements Rc Lighting Power
Requirements

Controls

The building complies if its total connected power is
no greater than the interior lighting power allowance

|

Switching

Interior Lighting

MEEA

MIDWEST ENERGY EFFICIENCY ALLIANCE

Power Allowance
(805.4.2)

Entire Building

l

Partial Building

NEBRASKA
CODE OFFICIALS
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—— Adding Lighting

& EZ - Casestudy.cck - COMcheck Code: 2001 IECC
File Edit View Options Code Help
DT EH ¥ W@l Xi= &
Project Envelope Lighting Mechanical
] T8/T12 Fluotescent || Compact Fluorescent || HID || Incandescent | Add Space
. - Sioe Lamp Description/ Lamps Per Number of Facdture
Component tutuelo Fucture Description Wattage Pes L | Balast Fodure \ Bakians Wattage
1 | Space 1 | g | | m—
2 2 5 ic Troff | T12 40W - M j ~ 4 - 174 138
= ] Lighting components are [ N2 {Megnetic | =l. -
3 | SRt Troffer 48" T12 40W ZMagnetic = 2 =l . =
a | added by clicking on these cTroffer |48" T12 40w “lMegnetic =i 2 | s 70
| s | TSI rrZroorescenm s o Zxz ic Troffer |24 T12U 40wV _vJ“Mwuc ;l 2 ;j 53 | 70
= T8/ T12 Fluorescernt 2 E 12 x 4 Prismatic Troffer |48~ T12 40W v || Magnetic ~| [ -
=== : : - =l = I Lighting Results T
Allowed Wattage 28295 Proposed Wattage 31186
Envelope T8D Lighting

IUse the Options Menu to Arrange Lighting Fixdures by Spaces.
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. Functional Testing of Lighting Controls

.. Section C408.3.1

* Prior to passing final inspection, registered design
professional to provide evidence that lighting control
systems have been tested to ensure that control
hardware and software are calibrated, adjusted,
programmed and in proper working order per
construction documents and manufacturer’s installation
INstructions.
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Lighting Using Space-by-Space

Future
Bath- Development
Oﬁice A: 400 ft* Office A TS
Office B: 850 ft2
Bathrooms: 350 ft2 =
Corridor: 50 ft2 Corridor
Retail A: 500 ft2 N
Retail B: 500 ft2 Retail A
Future: 350 ft2 Retail B
Office B
Total Building Area = 3000 ff
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Mechanical Systems and SWH Commissioning
Section C408.2

* Prior o the final mechanical and plumbing sections, the
registered design professional or approved agency shall
provide evidence of mechanical systems commissioning and
completion in accordance with section C408.2

* Mechanical Systems exempt from commissioning
requirements (all other systems must comply)
 In buildings where total mechanical equipment capacity is

< 480,000 Btu/h (40 tons) cooling capacity and < 600,000 Btu/h
combined service water heating and space-heating capacity

» Included in Section C403.3 that serve individual dwelling units and
sleeping units

NEBRASKA
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&l EZ Casestudy.cck - COMcheck Code: 2001 IECC
File Edit View Options Code Help

0D &

@B XS &

Mechanical

Project

Envelope Lighting Mechanical )

[ HVAC System || Plant || Water Heating

Conporer omay| Epimct | SuDow | Coees | gmen

Busding '1 | ' |
1 s Hoating =] | | T —
2 | = HVAC System 4 | 1 ! ! | |
3| Rooftop Packaged Heat Py [Select I [Select B ||
- | S HVAC System 1 . 1 | | | |
S| Rooftop Packaged Heat P | <65 KBtumh e || Ar-Cooled || |
6 | = HVAC System 2 | @ | | ' | |
7 || Rooftop Packaged Heat Py | <65 kBtuh ~ |Ar-Cooled || |
8 | = HVAC System 3 2 | |
9 | Rooftop Packaged Heat PL »=80 - <135k_. ]| |Ar-Cooled || Aur Econormizer |

The Mechanical section generates a customized list of mandatory
requirements applicable to the mechanical components you identify.

Envelope TBD Lighting

-10%

Use the View Menu to display Requirements.

¢
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@] EZ-Casestudy.cck - COMcheck-EZ Code: 2001 IECC
File Edit View Options Code Help

DB »
Project  Enve

HVAC System

HVAC Equipment Type

Heating Equipment Type: Cooling Equipment Type:
oce: & None & None

___|Building O Central Fumace O Field-Assembled DX System

1 | | Water Heating 1 O Duct Furace O Hydronic Coil
2 |5 HVAC System 4 O ic or St Coil

3 Rooftop Pac Hydronic or Steam Coi O Packaged Terminal DX Unit
4 | = HVAC System 1 O Heat Pump O Rooftop Package DX Unit

S Roottop P .
= ! s . Split DX tem
6 | = HVAC System 2 O Radiant Heater O s By

; Rooftop O Unit Heater £ Oy

= HVAC System

8| roonop ] Oome

Zoning Category:

[ oK ] [ Cancel |

Envelope T8D Lighting = -10%

IUse the View Menu to display Requirements.
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"
I
|

I

'

i

Ittt il

Code: 2001 IECC

File Edit View Options Code Help

D E »¥ Wm X & |
Component "UU!I!E' Fuel Type/ Condenser System
Capacity Heat Sowce Type Detais
= Building L
1 | Wvater Heating 1 2 L Chck here. J
2 | = HVAC System 4 E 1 i) A .
! Rooftop PackagedHeat Py~ [Sel
| = HVAC System 1 1 | : s
- - . Systermn Has a Ceculation Pump
| ] | Rooftop Packaged Heat Py - .<6 L] Sys .
6 | = HVAC System 2 - .] [] Heat Trace Tape Installed n the System i
r 3l Rooftop Packaged Heat Py <6 - o
- 4 K Cancel
= ] (B ] o ( ) ]
(9 | Rooftop Packaged Heat Py »= T3S o1l T Air Economizer
Envelope TBD Lighting @ -10= | J
Use the View Menu to display Requirements.
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Alteration Type Project:

»Projects involve changes to or replacement of
 Existing building components that are part of building envelope

« Lighting, heating, ventilating, air conditioning, and water-heating
equipment

»Specify only those envelope components, lighting fixtures, or mechanical
systems/equipment that will exist upon completion of the project

> Alteration detail dialogs
« Specify exemptions if applicable
« Additional qualifications may be required (e.g., Window/wall ratio)

»Compliance shown as Pass/Fail for Envelope and Lighting

NEBRASKA

Good Life. Great Resources. | 48
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Existing Buildings
.. Section C503 - Alterations

« Code applies to any new construction
« Additions or new work in existing structures

.. « Unaltered portion(s) may not need to comply

« When complying via ASHRAE 90.1-2016,

. alterations do not need to comply with C402-
® -

« Where existing building exceeds fenestration
. area limitations of Section C402.4.1 prior to

alteration, building is exempt from C402.4.1

.. provided there is no increase in fenestration
ared

NEBRASKA

Good Life. Great Resources.

EEEEEEEEEEEEEEEEEEEEEEEEEEE

4 L *
) o
. - :
"-'-)h‘*l - P e

Image: montgomerycountymd.gov
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Existing Buildings
Section C503 - Alterations

« Heating and Cooling

« New HVAC systems and duct systems that are part of the alteration
to comply with Section C403

 Service hot water systems
« New SWH systems that are part of the alteration to comply with C404
* Lighting Systems

* New Lighting systems that are part of the alteration to comply with
C405

« Exception — alteration that replace <10% of the luminaires in a space

provided such alteration does not increase the installed interior lighting
power

NEBRASKA

Good Life. Great Resources.
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. Existing Buildings - Lighting Power and Systems

.. Section C502.2.6

lc\l:%\/Sligh’ring systems installed as part of an addition to comply with

 Total interior lighting power to comply C405.3.2
« Stand alone addifion
« Addition + existing building as a single building

« Total exterior lighting power to comply C405.4.2

« Stand alone addition
« Addition + existing building as a single building

« Repairs — C504.2

« Repairs exempt where only the bulb, ballast or both within the existing
luminaires in a space are replaced, provided that the replacement does
not increase the installed interior lighting power

NEBRASKA
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Building Controls are Complicated

» Since 2004, about 30% of all new requirements have
been related to building controls

« Control requirements can be difficult fo implement and
verification is beyond the expertise of most building
code officials

« Assumption is that they are implemented and working
correctly

Source: hitps.//www.pnnl.gov/main/publications/external/technical reports/PNNL-
26348.pdf

NEBRASKA
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Mandatory Requirements in COMcheck Software

> Requirements Checklist generated automatically based on input
applicable code
building location

Esvelope Compliance Certificate
2091 IECC

CORAR N L Safrsars Yarmow 3 D Fawam 2

O Masams . C Wrogram FAesCReck OO ek B2

Sectien 1 Pxeject Bf crznation

romatems  comcees Air Leakage, Component Certification,

and Vapor Retarder Requirements:

All joints and penetrations are caulked,
gasketed, weather-stripped, or otherwise
sealed

Sectien 7 Cervxal Inf cxrsasion

P by Lo o |V st bl )
Chamse Zowe

Memiag Degree Days (b 45 Sagreds
Coxma g Degred Days (s b Stpecal

AN Lessage, Compotest CorMMua™on asd Vajor Keatardey Sogqus ety

I AR et aet gt i cmd St AR d, SARCIS, WA BGPea, v RS rae aed
] oy GUors el BV IR Cernted A8 @ 0he ) CEEARE T QU TER et

3 Comgpimtm st s B UG- Naisirs e d as <o fea
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. Systems Commissioning and Completion
Req Uirements Benefits of Commissioning

by e

.. « Commissioning is critical to ensure E‘ Jrl""

that buildings are working as bt

Increased ,';" S
I and safisfaction  building system life BESEEE ey
des'gned resulting in higher e 5
productivity ‘

. * Preliminary and final reports

. required

* Mechanical and lighting
commissioning detailed in section N
C408 T

with a building, etc.
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. Functional Testing of Lighting Controls

.. Section C408.3.1

* Prior to passing final inspection, registered design
professional to provide evidence that lighting control
systems have been tested to ensure that control
hardware and software are calibrated, adjusted,
programmed and in proper working order per
construction documents and manufacturer’s installation
INstructions
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ompliance Certificate for Permit
@@ )\ lel gT=Tal

COMcheck Software Version COMcheck-Web
Envelope Compliance Certificate

Project Information

Energy Code 2012 Ontario Building Code and Chapter 2 of Division 3 of SB-10(2017)
Project Thtle OAA Festival Project 44%
Location Toronto / Downtown, Ontario
Chrmate Zone 5a
Project Type New Construction
Veartical Glazing / Wall Area 43%
Performance Sim. Specs EnergyPlus 8.1.0.009 (EPW: CAN_ON_Toronto. 716240 _CWEC epw)
Conatruction Ste Owner/Agent Designer/Comtractor
666 Park AVe ima Driven Gerry Conway
Toronto, Ontario MaM aM4a CanbDo Developments Conway Architect Inc
666 Park Ave 185 Mafeking Ave
Toronto, Ontario MAM 4M4 Ottawa K1K2va
6136015689 6136015689
Ima.Driven@CanDo.ca ConwayArchitect@gmail.com
Building Area Floor Area
1-Gnd Fi. Retall (Retall) : Nomresidential 10000
2-2nd - 10th (Office) . Nonresidential 90000
3-8Bsmt. (Warehouse) | Nonresidential 10000
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.. « Late August (Exact date TBD) — In-person fraining in the
Grand Island areaq, stay funed.

Upcoming Trainings

« Would you like an in-person training in your areae Let us
know!

NEBRASKA
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Thank You! Questions?

Matt Belcher, Verdatek Solutions

matt@verda-solutions.com
Cell: (314) 749-4189

John Gossman, MEEA
jgossman@mwalliance.org
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